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Definition of terms: 

◼ Copernicus Stakeholders: Most generic reference to the large Copernicus family of individuals and entities involved in 

the Copernicus programme 

◼ Copernicus users: Refers to individuals, industries, research, public entities, etc. actually using and benefiting from 

Copernicus data, services and added value services 

◼ Copernicus potential users: Refers to the said individuals or communities, knowledgeable of Copernicus, that have 

not yet begun using it for the implementation of their mandate or obligations.   

◼ Copernicus Entrusted Entities (EEEs): Dedicated service providers through "Delegation Agreements” by the 

European Commission for the implementation and operation of Copernicus [core] services". 

◼ Copernicus Service Providers: Dedicated service providers, either institutional or industrial, through Framework 

Contracts with the EEEs, for the development of core services 

◼ Copernicus downstream service providers: Dedicated service providers, either institutional or industrial, that 

implement the core services with specific added value assets. 

◼ Copernicus Networks: Refers to the Copernicus Academy and Copernicus Relays 

◼ Copernicus Ecosystem: Refers to the overall Copernicus components and architecture: services, providers, users, 

EEEs, Relays, RUS, Academy, DIAS platforms, National Representatives, National Fora, Copernicus User Forum  

◼ Copernicus User Forum (CUF): EU Member States representatives assisting the Commission in relation to the 

implementation of existing Union legislation, programmes and policies, in the preparation of delegated acts and providing 

expertise to the Commission when preparing implementing measures, i.e. before the Commission submits these draft 

measures to a comitology committee 

◼ Copernicus data: Refers to raw data provided by geo-positioning GNSS, Sentinel mission, third party contributing 

missions and in situ data  

◼ Copernicus information: Refers to Copernicus data and Copernicus Services, either core or downstream added value. 

COPERNICUS ENTRUSTED ENTITIES DOMAIN 

EEA    European Environment Agency Land 

JRC    Joint Research Centre Land 

JRC    Joint Research Centre Emergency 

ECMWF   The European Centre for Medium-Range Weather Forecasts Atmosphere 

Mercator Ocean   Mercator Ocean Marine 

ECMWF   The European Centre for Medium-Range Weather Forecasts Climate Change 

FRONTEX   Agency for the Management of Operational Cooperation at the External  
  Borders of the Member States of the European Union 

Security 

EMSA    European Maritime Safety Agency Security 

SatCen   European Union Satellite Centre Security 

 



 
 
  

 

  Version: 1.2 
Date: 30/09/2019 

Page 5 of 22 

 

 
 
 

 
 
 

  
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 

 
 
 

 

Content 

CoRdiNet Pilot Projects Description Sheets ............................................................................................................................ 6 

1 Monitoring phenology in National Parks for Nature Conservation in Spain (GMV) ........................................................ 7 

2 Satellite crop monitoring needs for national control and paying agencies (TeRN) ......................................................... 9 

3 Protecting biodiversity from Invasive Alien Species (GMV) ......................................................................................... 10 

4 Monitoring Natural Habitats Status (GMV) .................................................................................................................. 12 

5 Forest Characterisation and Condition (GMV) ............................................................................................................. 14 

6 Ecological status of inland waters (GMV)..................................................................................................................... 16 

7 Active Volcano Surveillance (TeRN) ............................................................................................................................. 18 

8 Control of agricultural subsidies (Bavairia) .................................................................................................................. 20 

9 Soil water forecast (ULEIC) .......................................................................................................................................... 22 

 

 

  



 
 
  

 

  Version: 1.2 
Date: 30/09/2019 

Page 6 of 22 

 

 
 
 

 
 
 

  
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 

 
 
 

 

 

CoRdiNet Pilot Projects Description Sheets  

CoRdiNet supports the creation of pilot projects to create business links between users and suppliers of Copernicus related 
services. In more commercial and market oriented words, the objective is to find needs for the use of Copernicus data and 
added value services amongst tractor end users.  

“Tractor” end users are certainly found amongst Public Administrations, national or international, regional or local, bound by 
legal frameworks in which Copernicus may be used as a tool for knowledge and decision making. Other tractor end users worth 
noting are large industries or industrial sectors. 

In the course of CoRdiNet Project, WP4 has hosted or participated in 69 Copernicus uptake events, fostering the match 
between Copernicus tractor end users’ and Copernicus added value developers. Moreover, led by Nereus, two public calls for 
the development of small demonstration projects have gathered 24 proposals, showcasing concrete Copernicus solutions to 
specific needs.  

CoRdiNet team gathers in this document a synthesis of needs claimed by tractor users which can be supported or boosted with 
specific Copernicus based products developed by down-stream providers. From the scientific and technical point of view, the 
quality of the products is backed up by validation processes published in peer reviewed papers or the result of competitive 
projects.  

At times, although the need of EO data for institutional reporting is recognised, its use is limited and satellite data has not 
disrupted the standard procedures used to date in the classical reporting procedures. These Pilot Projects Description Sheets 
select specific needs, mostly nature and environmental conservation oriented, and one specific available solution (out of many 
possible) produced by the EO downstream market.  

CoRdiNet Pilot Projects Description Sheets strive to facilitate tractor EO users to consider and dare to use these new means of 
data information and validation in the mandates and competences they are obliged to attain.  

CoRdiNet members have been in contact with tractor end users with specific needs for Copernicus data and added value 
services: Public Administrations, national or international, regional or local, bound by legal frameworks in which Copernicus 
products may be used as a tool for knowledge, reporting and decision making.  

The Pilot Projects Description Sheets select a specific need, mostly nature and environmental conservation oriented, and one 
specific available solution (out of many possible) produced by the EO downstream market. The quality of the products is 
recognised by scientific peer reviewed processes (papers, patents, prototypes). 

The relationship between the need and the solution is not yet established. The Pilot Project Description Sheet is intended as a 
working document for exploring how the disrupting technologies and solutions offered by Copernicus data could facilitate the 
reporting obligations of certain public administration levels and other large corporations. The sheets are open windows to the 
market. 

Thus, these samples seek to facilitate Copernicus Users and service providers to answer key questions such as:  What 
reporting legal frame or procedure obliges to produce thematic data that are not available? Is the traditional reporting process 
compliant with the digitalisation goals? Are classical reporting procedures economically viable? Could Copernicus data or 
thematic products disrupt and improve institutional reporting? Could Copernicus minimize institutional data gathering costs?  
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1 Monitoring phenology in National Parks for Nature Conservation in Spain (GMV) 

  

Pilot Project Description Sheet 

Need OAPN (Organismo Autónomo de Parques Nacionales, Spain) Needs remote sensing to obtain 

information on nature conservation of the natural Systems protected under the 15 National 

Parks and other joint sites. Needs  

◼ Vegetation greenness indicators related to primary gross biomass production  

◼ Phenology and seasonality records 

Topic. Application area Nature Conservation  

Issued by, Institution, Entity, 

Country  

Organismo Autónomo Parques Nacionales (OAPN), Spain  

National Parks Authority, Spain (Ministry of Environment. Ministerio para la Transición 

Ecológica y el Reto Demográfico) 

Legal frame of the need. 

Reporting Obligations 

scenario  

Law 30/2014, of National Parks; Royal Decree 389/2016), Plan for National Parks, which 

includes the REMOTE system, based on MODIS and Landsat. No direct reporting to EU 

domains. However, National Parks report to the National Nature Data Bank, which does report 

to EU level 

Year  Monitoring, on going  

How was the need covered 

till present 

Modis and Landsat data sets  

Copernicus product solution EEA Forest High Resolution layers 

EEA, Copernicus Natura 2000, protected sites, Coastal areas  and Riparian zones 

These could serve sa excellent support  

Solution Provider Added value Service provider in Spain: GMV. 

Data set  Sentinel 1- Sentinel 2  

Methodology  The requirements Vegetation greenness indicators related to primary gross biomass 

production and Phenology and seasonality records are linked to the forest age and to the 

continuous monitoring of the Canopy The product is obtained by analysing of 

multitemporal satellite data derived from Landsat (1984-2015) and Sentinel-2 

(from 2016 onwards) missions. Due to the length of data record, the product 
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cannot distinguish age ranges beyond 30 years and a unique category is assigned, 

which is labelled “older than 30 years” 

Technical specifications  Update Frequency → Annually updated with the forest disturbances product 

Accuracy → 80-90% 

Format → Classification image in raster format (.tif) and metadata (.txt) 

Optional deivery online 

Input data → Sentinel-2. Landsat 5-8. 

Archive Length → Landsat 5-8, since 1984. Sentinel-2, since 2016. 

Spatial resolution → 10m. Landsat output is downscaled from 30 to 10m to match Sentinel-2 

resolution. 

Minimum Mapping Unit → 0.1 ha (equivalent to 10 pixels/10m pixel) 

Expected impact  On Sustainable forest managers and public officers bound to reporting in the following aspects  

• Forest Inventory  

• Forest and Natural Resources Management 

• Land Use planning and Land use and Land Cover Dynamics Monitoring 

• Environmental Assessment 

• Biomass estimation and carbon offset projects 

• Biodiversity conservation 
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2 Satellite crop monitoring needs for national control and paying agencies (TeRN) 

 

  

Pilot Project Description Sheet 

Need The agricultural subsidies required by the European farmers to the National Control 

Paying Agency (NCPA) for implementing the Common Agricultural Policy (CAP) 

represents about 40% of the EU’s yearly budget. NCPA has to manage the following 

issues:  

◼ Mapping of areas 

◼ Recognize crops 

◼ Trace back to previous crops 

Topic. Application area European funds management, Agriculture 

Issued by, Institution, Entity, 

Country  

National Control and Paying Agency (NCPA), Europe 

https://ec.europa.eu/sfc/en/system/files/ged/Paying%20Agencies%20List.pdf 

Legal frame of the need. Reporting 

Obligations scenario  

Common Agricultural Policy (CAP) 

Year  Monitoring, on going  

How was the need covered till 

present 

By orthophoto 

Copernicus product solution Season crop mapping  

Solution Provider Added value Service provider: Various added value companies  

Data set  Sentinel 2A/2B; Landsat 7-8 

Methodology  C. Filizzola, R. Corrado, A. Falconieri, M. Faruolo, N. Genzano, M. Lisi, G. Mazzeo, R. 

Paciello, N. Pergola, V. Tramutoli (2018). On the use of temporal vegetation indices in 

support of eligibility controls for EU aids in agriculture. International Journal of Remote 

Sensing, Special Issue "Advances in Remote Sensing applications in Silvo-Pastoral 

Systems" Vol.39, pp. 4572-4598. Published online: 09 Nov 2017. (ISSN: 0143-1161). 

Technical specifications  Global coverage, up to 3 days revisit time 

Expected impact  Support to the local and national public authorities   

https://ec.europa.eu/sfc/en/system/files/ged/Paying%20Agencies%20List.pdf


 
 
  

 

  Version: 1.2 
Date: 30/09/2019 

Page 10 of 22 

 

 
 
 

 
 
 

  
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 

 
 
 

 

 

3 Protecting biodiversity from Invasive Alien Species (GMV) 

  

Pilot Project Description Sheet 

Need Invasive alien species (IAS) are an economic problem, these species cause more than 

12 billion EUR economic loses every year in Europe, hazards to human health and 

damage to infrastructure and agricultural losses. IAS are also a biodiversity problem, in 

Europe, there are over 12,000 alien species, 15% of which are invasive. These species 

are the third most severe threat to European threatened species. 

Needs: 

◼ Vegetation indexes and spectral properties of Invasive alien plants species 

(IAPS) 

◼ Mapping of IAS extension 

◼ Damage Assessment 

Topic. Application area Invasive Alien Species (IAS), Biodiversity 

Issued by, Institution, Entity, 

Country  

The Ministry for the Ecological Transition and the Demographic Challenge (MITECO), 

Spain 

Regional Administrations, Spain 

Legal frame of the need. Reporting 

Obligations scenario  

Regulation (EU) 1143/2014 on invasive alien species (the IAS Regulation), Europe 

EU 2020 Biodiversity Strategy, Europe 

Commission Implementing Regulation (EU) 2017/1454 of 10 August 2017 specifying the 

technical formats for reporting by the Member States pursuant to Regulation (EU) No 

1143/2014 of the European Parliament and of the Council, Europe. Spain, as Member 

State, has reporting obligations every six years about the distribution of the invasive alien 

species, the action plans undertaken and other obligations established in the Article 24(1) 

of Regulation (EU) No 1143/2014. 

Law 42/2007, Of December 13, Of Natural Heritage And Biodiversity, Spain. 

Year  Monitoring, on going  

How was the need covered till 

present 

Orthophotos, Landsat, MODIS, Sentinel 2A/2B, 
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Copernicus product solution Product non-existent as such. Some EEA land products can provide side information on 

native class species 

Solution Provider Added value Service provider: GMV  

Data set  Sentinel 2A/2B, Landsat, EnMAP 

Methodology Vegetation indexes sucha as NDVI, EVI and other derived indixes to detect invasive alien 

species. 

Possible use of images from the future hypespectral EnMAP satellite to improve the 

identification of the invasive alien plants species through their particular spectral 

properties. 

Evaluation of the damage caused by Bark Beetle In Remote Sensing Journal  

https://www.mdpi.com/2072-4292/12/21/3634  By A. Fernandez-Carrillo, at al  2020 

Technical specifications  Update Frequency → Customizable. Minimum production update 5-days 

Accuracy → 85-90% 

Format → Classification image in raster format (.tif) and metadata (.txt) 

Optional delivery online 

Input data → Sentinel-2 imagery 

Archive Length 2016 - Present 

Spatial resolution → 10 m 

Minimum Mapping Unit → 0.1 ha (equivalent to 10 pixels/10m pixel) 

Temporal coverage → Several images are required to perform a monitoring of 

subsequent pest outbreak and diseases as of reference date. 

Spatial coverage → Use global coverage input data. Customizable local/regional set up 

Requires Field Data→ No 

Validation → To do any comparison with ground datasets, field spatial data need to be 

available at the time of event. 

Expected impact  Support to the regional, national public authorities on plant heath and pests contrpl  

https://www.mdpi.com/2072-4292/12/21/3634
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4 Monitoring Natural Habitats Status (GMV) 

  

Pilot Project Description Sheet 

Need Member States must report every six years about the progress made with the 

implementation of the Habitats Directive, focusing on capturing the status and trends of 

the habitat types and species of community interest. Needs: 

◼ Distribution map 

◼ Status of habitat area 

Topic. Application area Landscape Ecology, Ecosystem Restoration, Environmental Impact Assessment, Wildlife 

management 

Issued by, Institution, Entity, 

Country  

The Ministry for the Ecological Transition and the Demographic Challenge (MITECO), 

Spain 

Legal frame of the need. Reporting 

Obligations scenario  

Law 42/2007, Of December 13, Of Natural Heritage And Biodiversity 

Council Directive 92/43/EEC of 21 May 1992 on the conservation of natural habitats and 

of wild fauna and flora, Europe 

Year  Annual 

How was the need covered till 

present 

Information registered through National/regional forest inventories.  

Direct monitoring of habitats 

Copernicus product solution EEA Copernicus High Resolution Layers products for Forests, grasslands, small woody 

features and water and wetness provide good background. Updated every 3 years. 

Solution Provider Added value Service provider: GMV 

Data set  Sentinel 2A/2B 

Methodology  Measurement of the habitat fragmentation by classifying spatial patterns and vegetation 

density. This product has been developed for forest applications but it could be adpated 

to other types of habitats. 

Technical specifications  Input data →Sentinel-2 imagery 

Archive Length  →2016 - Present 

Spatial resolution →10 m 

Minimum Mapping Unit →0.1 ha (equivalent to 10 pixels/10m pixel) 
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Temporal coverage →Several images are required to include seasonal foliage conditions 

in the same reference year 

Spatial coverage →Use global coverage input data. Customizable local/regional set up 

Requires Field Data →No 

Validation →Whenever available, the habitat fragmentation product can be validated 

against information from National Forest Inventory or other national datasets. 

Expected impact  Supporting administrations on the reporting in the frame of the Habitats Directive. 

Monitoring and management of the Natura 2000 network. Areas of application 

• Landscape Ecology 

• Ecosystem Restoration 

• Environmental Impact Assessment 

• Wildlife management 
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5 Forest Characterisation and Condition (GMV) 

 

  

Pilot Project Description Sheet 

Need Forest ecosystems should be protected and enhanced in order to reach a healthier 

environment and to support the forestry industry. Several EO services could be of great 

help for the monitoring and management of forest ecosystems. Needs: 

◼ Forest characterization (extent and evolution of species)  

◼ Forest condition (health) 

Topic. Application area Forestry, Forest conservation, Environmental Impact Assessment 

Issued by, Institution, Entity, 

Country  

Public sector with management and reporting commitments. Ministry for ecologic transition 

of Spain  

Legal frame of the need. 

Reporting Obligations scenario  

Spanish forest law -Ley 43/2003, of 21 November 2003-. BOE-A-2003-21339, 

Year  Every second year for the extent and spatial evolution of species. Once a year for the health 

forest condition  

How was the need covered till 

present 

By the National Forest Inventory  

Copernicus product solution EEA Copernicus High Resolution Layers products for Forests, grasslands, small woody 

features and water and wetness provide good background. Updated every 3 years. 

Solution Provider Added value Service provider   

Data set  Sentinel 1, Sentinel 2A/2B, Landsat 5-8 

Methodology  There would be provided the following products: forest mask, main forest type, forest age, 

burnt scars, clear cuts, timber volume, above-ground biomass and CO2 stock. 

Technical specifications  See technical specifications at https://mysustainableforest.com/services/portfolio/ 

A Forest Mask classifies forest/non forest land coverages (a binary forest land 

classification). The forest mask product is the basis for other products such as forest type 

classification or vegetation stress monitoring. These products can be made in High 

Resolution, Very High Resolution or with LIDAR. 

https://mysustainableforest.com/services/portfolio/
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Main forest types: A supervised image classification which provides a map of the dominant 

species spatial distribution and identifies the mix of species present within an area. A 

preliminary desk study of dominant species or forest communities is required 

The Forest Age product is obtained by analysing of multitemporal satellite data derived 

from Landsat (1984-2015) and Sentinel-2 (from 2016 onwards) missions. Due to the length 

of data record, the product cannot distinguish age ranges beyond 30 years and a unique 

category is assigned, which is labelled “older than 30 years”. 

Burnt forest areas are mapped out using change detection techniques between two dates 

(pre-fire/post-fire). The analysis allows estimating burnt severity to support recovery plans.  

Clear cuts detect areas where forest has been cut. It requires a forest mask for a given 

initial date. Change detection algorithms are used to detect forest changes due to logging 

practices. 

The Timber Volume, Biomass and CO2 Stocks service provides estimations of the living 

volume of trees in a forest and its CO2 stock. These products are key for the forest biomass 

industry and carbon accountings. 

Expected impact  Support to the public authorities  and to the forest industry 
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6 Ecological status of inland waters (GMV) 

  

Pilot Project Description Sheet 

Need EU Water Framework Directive (WFD) commits Member States to 

achieve good qualitative and quantitative status of all water bodies. 

Needs: 

◼ Ecological status of inland waters (Chlorophyll-a as indicator of 

eutrophication) 

Topic. Application area Water management 

Issued by, Institution, Entity, 

Country  

Public sector with management and reporting commitments. River basin 

districts, Spain 

Legal frame of the need. 

Reporting Obligations scenario  

Directive 2000/60/EC of the European Parliament and of the Council 

establishing a framework for the Community action in the field of water 

policy. 

Law 62/2003, Of 30 December, Fiscal Measures, Administrative And 

Social Order. 

Year  On-going monitoring. Information needed weekly, linked to specific 

weather conditions of heat spells.  

How was the need covered till 

present 

In-situ data. Measured by river authorities 

Copernicus product solution EEA Copernicus High Resolution Layers product for water and wetness 

provides good supportive background. Updated every 3 years. 

Solution Provider Added value Service provider: GMV 

Data set  Sentinel 2A/2B 

Methodology  Chlorophyll-a as indicator of eutrophication of waters to measure water 

quality status. 

Ansper, A.; Alikas, K. Retrieval of Chlorophyll a from Sentinel-2 MSI Data 

for the European Union Water Framework Directive Reporting Purposes. 

Remote Sens. 2019, 11, 64. 

Technical specifications  Input data →Sentinel-2 imagery 
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Archive Length  →2016 - Present 

Spatial resolution →10 m 

Minimum Mapping Unit →0.1 ha (equivalent to 10 pixels/10m pixel) 

Temporal coverage →once a week. Ideal, once every 5 days, 

particularly during hot seasons 

Spatial coverage →Use global coverage input data. Customizable 

local/regional set up 

Requires Field Data →No 

Validation →Whenever available, the Chlorophyll-a as indicator of 

eutrophication of waters product can be validated against information 

from the River Basin Authorities. 

Expected impact  Support to the public authorities , Regional, National and transboundary 

in shared river basins 
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7 Active Volcano Surveillance (TeRN) 

 

  

Pilot Project Description Sheet 

Need Thermal Remote Sensing may support volcanic observatories in the surveillance of active 

volcanoes. Needs  

◼ Accurate mapping of areas inundated by lava flows  

◼ Accurate localization of active vents 

◼ Identification of subtle thermal anomalies (e.g. possible thermal precursors of 

volcanic eruptions) 

Topic. Application area Natural Hazards 

Issued by, Institution, Entity, 

Country  

Volcano observatories especially those in developing countries where often there is a lack of 

expertise in processing satellite imagery. 

Legal frame of the need. 

Reporting Obligations 

scenario  

The Italian Department of Civil Protection has the function of addressing, promoting and 

coordinating the National Service of civil protection,  

• Legge n. 152 del 26 luglio 2005: disposizioni urgenti in materia di protezione civile 

• Decreto-legge n. 59 del 15 maggio 2012 convertito dalla legge n. 100 del 12 luglio 2012: 

disposizioni urgenti per il riordino della protezione civile 

• Legge n. 225 del 24 febbraio 1992: istituzione del Servizio Nazionale della Protezione 

Civile 

Year  Monitoring, on going  

How was the need covered 

till present 

Volcanoes monitoring through systems using high temporal resolution satellite data (e.g. 

Modis; SEVIRI). Thermal monitoring by means of in-situ techniques (e.g. thermal cameras) 

Copernicus product solution None of the proposed. Some meteo-products on ash flows.  

Support Information from the European Volcano Observatory Space services and national 

observatories 

Solution Provider Added value Service provider  Industry or Laboratory 

Data set  Sentinel 2A/2B 

http://www.protezionecivile.gov.it/transparent-administration/legal-measures/detail/-/asset_publisher/default/content/legge-n-152-del-26-luglio-2005-disposizioni-urgenti-in-materia-di-protezione-civile
http://www.protezionecivile.gov.it/transparent-administration/legal-measures/detail/-/asset_publisher/default/content/decreto-legge-n-59-del-15-maggio-2012-convertito-dalla-legge-n-100-del-12-luglio-2012-disposizioni-urgenti-per-il-riordino-della-protezione-civi-1
http://www.protezionecivile.gov.it/transparent-administration/legal-measures/detail/-/asset_publisher/default/content/decreto-legge-n-59-del-15-maggio-2012-convertito-dalla-legge-n-100-del-12-luglio-2012-disposizioni-urgenti-per-il-riordino-della-protezione-civi-1
http://www.protezionecivile.gov.it/transparent-administration/legal-measures/detail/-/asset_publisher/default/content/legge-n-225-del-24-febbraio-1992-istituzione-del-servizio-nazionale-della-protezione-civi-1
http://www.protezionecivile.gov.it/transparent-administration/legal-measures/detail/-/asset_publisher/default/content/legge-n-225-del-24-febbraio-1992-istituzione-del-servizio-nazionale-della-protezione-civi-1
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Methodology  Marchese, F., Genzano, N., Neri, M., Falconieri, A., Mazzeo, G., & Pergola, N. (2019). A Multi-

Channel Algorithm for Mapping Volcanic Thermal Anomalies by Means of Sentinel-2 MSI and 

Landsat-8 OLI Data. Remote Sensing, 11(23), 2876. 

Technical specifications  Global coverage, up to 3 days revisit time 

Expected impact  Support to the surveillance of active volcanoes and risk mitigation 
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8 Control of agricultural subsidies (Bavairia) 

 

  

Pilot Project Description Sheet 

Need The satellite data (VHR/HR) provided by EC are used to check on agricultural 

subsidies/payments and, in the framework of pilot projects, the use of Sentinel data is tested 

for the new area/plot monitoring procedures 

Topic. Application area The data are used for control procedures, to check on observance of eligibility criteria, 

obligations and other terms to be- come or rest eligible for state aids, which are checked via 

remote sensing 

Issued by, Institution, Entity, 

Country  

Bayerisches Staatsministerium für Ernährung, Landwirtschaft und Forsten – Zahlstelle 

Bayern  

(Bavarian Ministry for Nutrition, Agriculture and Forestry - Payment Agency) 

Legal frame of the need. 

Reporting Obligations 

scenario  

VO (EU) Nr.1306/2013, VO (EU) Nr.1307/ 2013, VO (EU) Nr.809/2014  

EU working documents: DSCG/2014/32 Final, Guidance CTS, 

22345_VHR_951_VHR_Specs, 22346_HR_71_HR_Specs 

Year, period Annual checks, exact periods depend on procedure to check on 

How was the need covered 

till present 

Checks are almost entirely done via remote sensing. Image data are provided via the 

contingent of EU-VHR (Worldview, GeoEye, KompSat), HR/HHR (SPOT). In addition, own 

image data are used, like orthophotos via own surveying flights or purchase of VHR image 

data (LandSat, Sentinel2, RapidEye) by Bavarian Agency for Digitisation, High-Speed 

Internet and Surveying or procurement via an external contractor. 

Copernicus product solution  

Solution Provider EO added value companies in collaboration with service agencies 

Data set  Sentinel 1 and Sentinel 2, PlanetScope 

Methodology  Methods used from machine learning (RandomForest) and neural networks methods - exact 

methodologies to be development during pilot projects 

Technical specifications  To be stated by the Regional/national paying agencies.  
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The EU Common Agricultural Policy sets minimum parameters, quite tight to achieve with 

sentinel data due to limited spatial resolution.. Artificial Intellgenceand multitemporal cloud 

computing techniques under test.  

Expected impact  Transformation of entire checking procedure and restructuring of control process. 
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9 Soil water forecast (ULEIC) 

 

  

Pilot Project Description Sheet 

Need ◼ Soil Water Forecast 

◼ Water Quality Analysis 

Topic. Application area Agriculture: irrigation, harvest optimisation, stabilisation of the food supply chain 

Issued by, Institution, Entity, 

Country  

Central Rift Valley Lakes (CRVL), Ethiopia  

Legal frame of the need. Reporting 

Obligations scenario  

Need expressed in the context of UK cooperation 

Need expressed in the context of GMES for Africa 

Year  2020  

How was the need covered till 

present 

Copernicus Land services, Sentinel-1 and Sentinel-2 data 

Copernicus product solution None at international level  

Solution Provider Added value Service provider   

Data set  Sentinel 1 A/B; Sentinel 2A/2B; 

Methodology   

Technical specifications  Initial local coverage, product scalable to global coverage, up to 5 days revisit time 

Expected impact  Support to the local farmers’ community and to the local and national public authorities   

 

 

 


